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1.0 Introduction

1.1 Why checkSTRESS?

It is common practice worldwide that piping designers/layout personnel route pipes with consideration
given mainly to space constraints, process and flow constraints (such as pressure drop) and other
requirements arising from constructability, operability and reparability. Unfortunately, often pipe stress
requirements are not sufficiently considered while routing and supporting piping systems, especially in
providing adequate flexibility to absorb expansion/contraction of pipes due to thermal loads. So, when “as
designed” piping systems are given to pipe stress engineers for analysis, they soon realize that the layout
is “stiff” and suggest routing changes to make the layout more flexible. The piping designers, in turn,
make routing changes and send the revised layout to the pipe stress engineers to check compliance
again. Such “back and forth” design iterations between layout and stress departments continue until a
suitable layout and support scheme is arrived at, resulting in significant increase in project execution time,
which, in turn, increases project costs.

This delay in project execution is further aggravated in recent years as operating pressures and
temperatures are increased in operating plants to increase plant output; increased operating pressures
increase pipe wall thickness, which, in turn, increase piping stiffness further; increased operating
temperatures, applied on such “stiffer” systems, increase pipe thermal stresses and support loads. So, it
is all the more important to make the piping layout flexible at the time of routing by piping designers.

In order to substantially reduce the number of design iterations between the piping layout and stress
departments, resulting in huge time savings during design, the “Design by Color” product “checkSTRESS”
was developed and released in 2010. Since then, a number of enhancements have been added.

1.2 checkSTRESS Modules

The preliminary visual pipe stress check software checkSTRESS is an add-on product to:
e 3D Plant Design software PDMS, PDS and CADMATIC

o 3D Plant Design software that generate “PCF” files from the plant database, such as SmartPlant
3D, AutoCAD Plant 3D, CATIA, CADWORX, etc.

The checkSTRESS product performs preliminary visual pipe stress check as follows.
¢ Reads the following from the plant database / PCF files of 3D Plant Design software
= Piping geometry, pipe sections and material properties
= Temperature, pressure and weight of pipe fittings
= Thermal anchor movements at equipment nozzles
= Pipe support details to create the corresponding hangers, guides, etc. in checkSTRESS
= Allowable loads at equipment nozzles

e Enables piping code compliance by displaying stress ratio contour plots for Sustained (weight +
pressure), Expansion and Occasional load cases.

e Assists in locating hangers and supports by showing deflected shapes for Sustained, Operating,
Expansion and Occasional load cases. Even sizes variable spring hangers.

e Generates input files for one or more of the widely accepted pipe stress software CAEPIPE,
CAESAR Il and PIPESTRESS (which is mostly used for nuclear piping analyses).

e Prints key results such as 10 highest stress ratios and their locations, equipment nozzle load
compliance with allowable loads, spring hanger report, “active/inactive” status of resting supports
during operation, Bill of Materials, Weight and Center of Gravity, and Table of Contents.




Currently, the following 3 modules of checkSTRESS are available for license.
checkSTRESS: generates stress input files only for CAEPIPE

checkSTRESS II: generates stress input files for CAEPIPE and CAESAR I
checkSTRESS Nuke: generates stress input files for CAEPIPE and PIPESTRESS

Excepting the generation of stress input files, the 3 checkSTRESS modules (available for each of the 3D
Plant Design software listed above) have identical features. Only checkSTRESS Nuke has an additional
feature of displaying animated mode shapes along with natural frequencies computed.

1.3 Benefits derived from checkSTRESS modules

1. During 3D layout stage, the Designer arrives at “flexible pipe routing with even supports including
spring hanger sizes” to meet the following stress criteria:

a. Comply with “Thermal Stress”, “Sustained Stress” and “Occasional Stress” requirements of
Piping Codes ASME B31.1, ASME B31.3, ASME B31.4, ASME B31.5, ASME B31.8, ASME
B31.9, ASME Sec lll Class 2, BS 806, Norwegian, RCC-M, Stoomwezen, CODETI, Swedish,
7183, 2184 and EN 13480.

b. Meet the Allowable Nozzle Loads at Equipment Nozzles/Anchors

2. During 3D layout stage, the Designer identifies all possible locations for pipe supports, as the 3D
plant model contains all supporting objects such as steel and concrete structures adjacent to the
concerned piping system. These possible locations for pipe supports, once marked in the 3D
plant model, are automatically transferred to the input files of pipe stress software.

3. The Designer transfers stress input files to the pipe stress engineers for mostly “code compliant”
and “fairly well supported” piping systems. Pipe stress engineers can then import these input files
into their pipe stress software (thereby avoiding recreation of stress models by pipe stress
engineers) and perform detailed analyses and stress report preparation.

4. The Designer confirms the validity of the piping layout finalized with supports by submitting key
results and relevant plots generated by checkSTRESS.

1.4 Basic Pipe Stress Concepts for Piping Designers
Piping systems experience different loadings, categorized into three basic loading types listed below.
Sustained Load:

It mainly consists of internal pressure and dead-weight. Dead-weight is from weight of pipes, fittings,
components such as valves, operating fluid, test fluid, insulation, cladding, lining etc.

Internal design/operating pressure develops uniform circumferential stresses in the pipe wall, based on
which pipe wall thickness is determined during the process/P&ID stage of plant design such that “failure
by rupture” is avoided. In addition, internal pressure develops axial stresses in the pipe wall. These axial
pressure stresses vary only with pressure, pipe diameter and wall thickness, which are already pre-set at
the P&ID stage and hence these axial pressure stresses cannot be reduced by changing the piping layout
or the support scheme.

On the other hand, dead-weight causes the pipe to bend (generally downward) between supports and
nozzles, producing axial stresses in the pipe wall (also called “bending stresses”); these bending stresses
linearly vary across the pipe cross-section, being tensile at either the top or bottom surface and
compressive at the other surface. If the piping system is not supported in the vertical direction (i.e., in the
gravity direction) excepting at equipment nozzles, bending of the pipe due to dead-weight may develop
excessive stresses in the pipe and impose large loads on equipment nozzles, increasing the susceptibility
to “failure by collapse”.




Various international piping codes impose limits, also called “allowable stresses for sustained loads”, on
these axial stresses generated by dead-weight and pressure in order to avoid “failure by collapse”.

For the calculated axial stresses to be below such allowable stresses for sustained loads, it may be
necessary to support the piping system vertically. Typical vertical supports to carry dead-weight are:

a) Resting steel supports,

b) Rod hangers,

¢) Variable spring hangers, and
d) Constant support hangers..

Both rod hangers and resting steel supports fully restrain downward pipe movement but permit pipe to lift
up at such supports. If pipe lifts up at any of the rod hangers / resting supports during operating condition,
then that support does not carry any pipe weight and hence will not serve its purpose.

In Appendix F titled “Sample Problems and Solutions using checkSTRESS”, a couple of sample layouts
are presented to illustrate how piping can be supported by spring hangers and resting steel supports to
comply with the code requirements for sustained loads.

Thermal Load (also referred as Expansion Load):

It refers to the “cyclic” thermal expansion/contraction of piping as the system goes from one thermal state
to another thermal state (for example, from “shut-down” to “normal operations” and then back to “shut-
down”). If the piping system is not restrained in the thermal growth/contraction directions (for example, in
the axial direction of a straight pipe), then for such cyclic thermal load, the pipe expands/contracts freely;
in this case, no internal forces, moments and resulting stresses and strains are generated in the piping.

If, on the other hand, the pipe is “restrained” in the directions it wants to thermally deform (such as at
equipment nozzles and pipe supports), such constraint on free thermal deformation generates cyclic
thermal stresses and strains throughout the system as the system goes from one thermal state to
another. When such calculated thermal stress ranges exceed the “allowable thermal stress range”
specified by various international piping codes, then the system is susceptible to “failure by fatigue”. So,
in order to avoid “fatigue failure” due to cyclic thermal loads, the piping system should be made flexible
(and not stiff). This is normally accomplished as follows:

a) Introduce bends/elbows in the layout, as bends/ elbows “ovalize” when bent by end-moments,
which increases piping flexibility.

b) Introduce as much “offsets” as possible between equipment nozzles (which are normally modeled
as anchors in pipe stress analysis). For example, if two equipment nozzles (which are to be
connected by a pipeline) are in line, then the straight pipe connecting these nozzles is “very stiff”.
If, on the other hand, the two equipment are located with an “offset”, then their nozzles will have
to be connected by an “L-shaped” pipeline which includes a bend/elbow; such “L-shaped” pipeline
is much more flexible than the straight pipeline mentioned above.

¢) Introduce expansion loops (with each loop consisting of four bends/elbows) to absorb thermal
growth/contraction.

d) Lastly, introduce expansion joints such as bellows, slip joints etc., if warranted.

In addition to generating thermal stress ranges in the piping system, cyclic thermal loads impose
loads on static and rotating equipment nozzles. By following one or more of the steps from (a) to
(d) above and steps (e) and (f) listed below, such nozzle loads can be reduced.

e) Introduce “axial restraints” (which restrain pipe in its axial direction) at appropriate locations such
that thermal growth/contraction is directed away from equipment nozzles, especially critical ones.

f) Introduce “intermediate anchors” (which restrain pipe movement in the three translational and
three rotational directions) at appropriate locations such that thermal deformation is absorbed by
regions (such as expansion loops) away from equipment nozzles.




In Appendix F titled “Sample Problems and Solutions using checkSTRESS”, a few sample layouts are
presented to illustrate how loops/offsets, axial restraints and intermediate anchors are used to reduce
thermal stresses in piping (and resulting nozzle loads).

Occasional Loads:

These are the third type of loads, which are imposed on piping by occasional events such as earthquake,
wind etc. To protect piping from wind (which normally blows in horizontal plane), it is normal practice to
attach “lateral supports” to piping systems. During an earthquake, the earth may also move vertically. To
protect piping against both horizontal and vertical movement during earthquake, some of the resting
supports may be made as “integral 2-way vertical and lateral restraints”.

checkSTRESS presently performs preliminary visual stress checks only for sustained (mainly dead
weight, pressure and other sustained mechanical loads), thermal loads and static seismic ‘g’ loads.

Fortunately, to carry sustained loads, normally vertical supports (as those listed under the Section titled
“Sustained Load” above) are required. To withstand static seismic ‘g’ loads, “integral 2-way vertical and
lateral restraints” are required. Generally, some of the vertical weight supports can be modified as
“integral 2-way vertical and lateral restraints”. On the other hand, for thermal loads, zero supports give
zero stresses. So, thermal stresses and equipment nozzle loads will normally decrease as the number of
supports goes down. Axial restraints and intermediate anchors are recommended only to direct thermal
growth away from equipment nozzles.

1.5 Recommended Procedure for checkSTRESS

The steps given below may normally be followed using checkSTRESS to perform preliminary visual
stress checks of piping systems designed using 3D plant design systems.

Stepl: Generating checkSTRESS model

Apply checkSTRESS on the piping system under consideration in the 3D plant model, as outlined in the
checkSTRESSPDMS / checkSTRESSPDS / checkSTRESSCADMATIC / checkSTRESSPCF Manual.

In case some of the important inputs (such as Thermal Anchor Movements at equipment nozzles and
Allowable Nozzle Loads) are not available in the 3D plant database/PCF file, they can be manually
entered using the “Edit Layout” button provided in checkSTRESS.

Step2: Studying Thermal Stress results for the Initial Layout

Review first stress contour plot for thermal stresses. The plot is color-coded such that “blue” region
denotes areas with the least stress ratios (where stress ratio equals to actual computed stress divided by
allowable thermal stress), “green” region with higher stress ratios, “yellow” region with even higher stress
ratios, and “red” region with the highest stress ratios. Intermediate areas between these distinct colors will

be of “bluish-green”, “greenish-yellow” and “orange” colors.

Since thermal stresses generated are directly dependent on how “flexible” the layout is, it may be
necessary to make the layout as “flexible” as possible (by including bends, offsets, loops etc.) to reduce
thermal stresses. So, the Designer’s goal is to arrive at a “flexible” layout for which thermal stress ratios
remain within “blue” to “yellow” range and not get into “orange” and “red” zones. For a more “flexible”
layout, even “yellow” zone may be avoided. That would leave even more thermal margin for stress
engineers to meet other pipe stress criteria not considered under checkSTRESS.

Step 3: Finalizing Layout to meet Thermal Stress criteria

In case thermal stress ratios exceed “yellow” zone (i.e., “orange” and “red” zones appear in one or more
areas of the piping system), it is important to study the deformed shape for “thermal” load case in order to
understand how the piping deforms for “pure thermal” load (where only temperature change is
considered). By studying such deformed shape, it is possible to arrive at a layout with appropriate bends,
offsets and loops and/or with appropriately located axial restraints/intermediate anchors such that thermal
stress ratios do not exceed “yellow” zone. This process may require the Designer to perform several
iterations on layout and/or locations for axial restraints/intermediate anchors.




Step 4: Studying Results for Sustained Load

After finalizing piping layout under Steps 2 and 3 for thermal loading, the next task is to support the
system vertically to carry its own deadweight under operating condition. In this connection, first review
stress contour plot shown in color codes from “blue” to “red” (as in Step 2 above) for sustained stress
ratios generated by deadweight and pressure for the system without any vertical supports (excepting
those provided by equipment nozzles and intermediate anchors introduced in Step 3 above).

The Designer’s goal is to arrive at a vertical support scheme consisting of (a) resting steel supports, (b)
rod hangers, (c) variable spring hangers and (d) constant support hangers, at appropriate locations
(where such pipe supports can be attached to adjacent concrete/steel structures, platforms etc.) so that
stress contour plot for sustained stress ratios avoids “orange” and “red” zones and remains within “blue to
yellow” range.

Step 5: Finalizing Vertical Supports to carry Sustained Load

In case sustained stresses exceed “yellow” zone in one or more areas of the piping system, study the
deformed shape provided by checkSTRESS for sustained load case in order to understand how the
piping responds to its own deadweight. Next, identify pipe locations in the 3D model where the pipe can
be vertically supported by the support types listed under Step 4 above. Based on this input, vertically
support the piping such that sustained stresses do not exceed “yellow” zone. This step may require the
Designer to execute checkSTRESS on the system with several different locations for weight supports.

checkSTRESS automatically sizes variable spring hangers wherever such hangers were located in the
3D model.

In case resting steel supports are selected to provide vertical support for piping under sustained load, it is
to be made sure that piping continues to rest on such steel supports even during operating condition (=
weight + pressure + thermal) and does not lift off from these supports. If pipe lifts up at any of these
resting supports during operating condition, then that support does not carry any pipe weight and hence
will not serve its purpose. Similarly, at rod hanger locations, the tendency of piping should be to deform
downward for operating load case, so that the rod hangers carry the pipe weight under tension. On the
other hand, if pipe lifts up at any of the rod hangers, then that rod hanger goes into compression thereby
not carrying the weight of the piping during operating condition. Whether the pipe weight is being carried
during operation by resting steel supports and/or rod hangers (both types are mathematically modeled as
one-way vertical Limit Stops in checkSTRESS) or whether the pipe lifts up at those support locations is
shown in the report titled “Status of Limit Stops — Operating Load”. The goal is to make sure the status is
shown as “Reached” at all vertical Limit Stops for Operating Load case.

Step 6: Studying Results for Static Seismic “g” Load

After arriving at a final layout with an acceptable pipe support scheme under Steps 2 to 5 for thermal and
sustained loads, the next task is to protect piping against large horizontal and vertical movements that

could occur due to static seismic “g” load. This can be accomplished by replacing some of the weight
supports with “integral 2-way vertical and lateral restraints”.

In this regard, review stress contour plot for occasional stresses generated by deadweight, pressure and

static seismic “g” load shown in color codes from “blue” to “red” (as in Step 2 above).

The Designer’s goal is to replace some of the weight supports (for example, resting supports) located in
the “yellow” to “red” zones with “integral 2-way vertical and lateral supports”, so that stress contour plot for
occasional stresses avoids “orange” and “red” zones and remains within “blue to yellow” range.

Step 7: Finalizing 2-way Vertical and Lateral Restraints to withstand Static Seismic “g” Load

In case occasional stresses exceed “yellow” zone in one or more areas of the piping system, study the
deformed shape provided by checkSTRESS for occasional load case in order to understand how the
piping responds to static seismic “g” load. Next, identify those weight support locations (for example,
resting supports) in the “yellow” to “red” zones where the pipe can also be laterally supported and replace
those weight supports with “integral 2-way vertical and lateral restraints”, such that occasional stresses do
not exceed “yellow” zone. This step may require the Designer to execute checkSTRESS on the system

with several different locations for “integral 2-way vertical and lateral restraints”.
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Step 8: Meeting Allowable Loads at Nozzles / Anchors

After locating relevant supports (a) to minimize thermal stresses, (b) to carry weight of the piping during
operation, and (c) to withstand static seismic “g” load, the Designer should check the calculated loads at
nozzles/anchors in the Support Load Summary. If the calculated loads at nozzles/anchors exceed the
corresponding Allowable Loads, by studying the deformed shapes provided by checkSTRESS for
different load cases, it is possible to further modify the layout and/or support scheme such that the

calculated loads at nozzles/anchors do not exceed the Allowable Loads.

As a minimum, the above said Nozzle Load compliance should be carried out for Operating L oad case.

Any such changes made to the layout and/or support scheme at this stage (i.e., at Step 8) should not
adversely affect the stresses for thermal, sustained and occasional load cases (i.e. all the 3 stress
contour plots should continue to avoid “orange” and “red” zones and remain within “blue to yellow” range).

This process may require the Designer to perform several iterations on layout and/or support scheme.
Step 9: Key Results to confirm Validity of Layout with finalized Support Scheme
Designers are to perform Step 1 to Step 8 for all relevant piping systems of the project.

Once the layout and support scheme are finalized for a system, the Designer confirms the validity of that
design by submitting key results generated by checkSTRESS as listed below.

a) Ten (10) highest stress ratios and their locations,
b) Equipment nozzle load compliance with allowable loads,

c) Report listing spring sizes, hot loads, cold loads and travel for variable spring hangers sized by
checkSTRESS,

d) Status of Piping at resting supports during operation (i.e., is the pipe resting on or lifting off a
resting support?),

e) Bill of Materials,
f)  Weight and Center of Gravity,
g) Table of Contents, and
h) Relevant stress contour plots and deflected shapes.
Step 10: Export checkSTRESS models to Pipe Stress Software input files

Piping systems, for which the layout and support schemes are finalized, can then be translated into stress
input files of the pipe stress software currently covered under the checkSTRESS modules (see
Subsection 1.2 above). Pipe stress engineers can then import these stress input files into their pipe
stress software and perform detailed analyses and stress report preparation. This eliminates (a)
generation of “stress isometric drawings” and (b) re-inputting the data into the pipe stress software.

Pipe stress engineers should check the stress models so sent by Designers and add additional input data
into the models such as insulation thickness and density, corrosion allowance and mill tolerance of pipe
sections, thermal anchor movements (if not already entered), seismic anchor movements, support
conditions such as friction and gap, other occasional loads such as wind and water/steam/fluid hammer,
multiple thermal and pressure cases, etc. and perform detailed analyses.

It is most likely that the layout with the support scheme finalized by Designers using checkSTRESS
should be able to meet all other pipe stress criteria (for examples, stress compliance for other thermal
ranges and occasional loads, leakage checks at flanges, qualification of lug attachments welded to pipes
etc.), thereby substantially reducing the number of iterations between stress and layout departments.




This manual describes the operational details of checkSTRESS. It is assumed that the user is already
familiar with the principles of Plant Design Software Piping Application and the practices followed in Plant
Design Piping catalogue and specifications, and the user has used Plant Design Software to generate the
piping by using available facilities in Plant Design Software.

The working sequence of the software is listed below.

1. The pipe branches modeled in the Plant Design Software are read and passed onto
checkSTRESS.

2. checkSTRESS then, from the material mapping database (see Note 1) provided with
checkSTRESS, identifies valid materials (which will be used for first level pipe stress calculations
within checkSTRESS) that would correspond to the material specifications given for those
branches in the Plant Design Software. This executable finally carries out stress analysis and
displays contour plots of Stress ratios for Sustained and Expansion cases. It also plots graphically
the deflected shapes for Sustained, Expansion and Operating load cases.

3. Finally, this software has a provision to write CAEPIPE 5.xx mod file, which is used for carrying
out detailed stress analysis and stress report preparation using CAEPIPE. See Note 2 below.

The sequence of checkSTRESS operation is shown diagrammatically in Figure 1-1.

Plant Design Software

R
N~

v Material and
P Support
checkSTRESS |« Mapping
Database (DB)
(see Note 1)

N

A A

Stress/Deflection Anchor / Nozzle Print Analysis Stress Input file
Plots, Status of Qualification Summary

Resting Support &
Hanger report Figure 1.1

Note 1: Refer Appendix B and Appendix D for more details.




2.0 Installing the Program

Before installing the SST License Manager and the Client product on any of your computer, please make
sure the computer meets the following requirement listed below.

Note:

If you are using the old version of SST License Manager (i.e., earlier than version 5.0), then follow the
procedure listed in Appendix A of Security System User's Manual on uninstalling the same before
installing the new version of SST License Manager.

2.1 Operating System Requirement

a. Internet Explorer 5.01 or later and Windows Installer 2.0 or later.
b. Windows NT 4.0 (Workstation or Server) with Service Pack 6a
c. Windows 2000 (Professional, Server, or Advanced Server)

d. Windows XP (Personal and Professional)

2.2 Installing SST License Manager

Locate/Decide the computer that you want to use as a server for the checkSTRESS Product. Any
machine available in the network can be used as a server machine and it is not necessary to be a real

server.

Insert the compact disc supplied by SST Systems Inc, to the CD-ROM drive of the computer that you
decided to use as a server for checkSTRESS product. Wait for few seconds to enable the “Auto play” of
the CD. Please note, if the CD-ROM does not start automatically, simply browse the CD, and double-click
on the “setup” application icon. You will see a typical window; similar to that shown in the figure left below.
The name shown on top left corner of the window changes depending upon the product and its module
you buy. For e.g., If you buy the product checkSTRESS and its module checkSTRESSPDMS, you will
see the name “checkSTRESS [for Aveva’s PDMS]” on the top left corner of the window.

Click on “Install SST License Manager” option. You will be shown window similar to that shown in the
figure right below.

L . =1
ChecksStress - SST Systems Inc., o] 1% /SST License Manager =)
— SST i
n —i -} Welcome to the SST License Manager Setup
Wizard
The installer wil guide you thraugh the steps required ta install ST License Manager on yaur
compLter
¥ g |
WARNING: This computer program is protected by copyright law and international trealies.
Unauthorized duplication ar distribution of this program, or any portion of it, may result in severe civi
o criminal penalties, and il be prosecuted ta the makimum extent possible under the aw
e
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Follow the instructions as they appear on the screen.




2.3. Manually Registering and Configuring the Windows Service for SST License
Manager

The SST License Manager Setup program will register and start the service automatically, when you
perform step 2.2. If the setup program fails to register the service automatically, then register the service
manually as stated below.

After the successful installation of the SST License Manager, launch the program “Manage License.exe”
by selecting Start Menu > Programs > SST License Manger > Manage License from the computer where
the SST License Manager is installed. The details are shown graphically below.

doPDF7 - n’

EaseUS Todo Backup Free 6.5
Games

Microsoft NET Framework SDK L
jcrosoft Develaper Netwark
Computer

< Live Mesting 2007
o e Tools

icrosoft Visual Studio .NET

icrosoft Visual Studio 6.0

ST License Manager

Manage License

Control Panel

Devices and Printers
Default Programs

STAAD.Pro 2004
Startup

B Help and Support

Select the option “Register SST License Manager” through “Tools” menu to register the window service
as shown in figure left below.

After successful registration of the service you will see a message shown in figure right below.

ﬂ 55T License Manager ‘

[Tcm-rs] Help
Analyse Tool Register 55T Licenze Manager il
Leimle s Hins L] "-n.‘ S5T License Manager Service Reaistered Successfully
Unregister 55T License Manager =
Exit

I

2.4. Installing the client program checkSTRESS

Locate/Decide the computers that you want to use as clients. The client program checkSTRESS can be
installed in many systems.

To install checkSTRESS on client computers, insert the compact disc supplied in to the CD-ROM drive
and wait for a few seconds to enable the Auto play feature. Please note if the CD-ROM does not start
automatically, simply browse the CD, and double-click on the “Setup” application icon. You will see a
window as shown in left figure of Section 1, “Installing the SST License Manager”.

Click on “Install checkSTRESS” option and follow the instructions as they appear on the screen. For
sharing the license information, client computer need to communicate with the server (computer where
the SST License Manger is installed). The communication between the client computer and the server
computer can be established by setting the Environmental Variable “SSTLM” on the client computers.
Please note, the automated procedure for locating the server computer by the client computer for sharing
license information is purposefully not given to avoid unnecessary clashes. However, the Environmental
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variable is set automatically for the machine where SSTLM is installed. In other words, if you install the
client program in the same machine where the SST License Manager is installed, then there is no need to
set the environmental variable “SSTLM”. If the client program is installed other than the machine where
SST License Manager is installed, then follow the procedure listed below for setting the environmental
variable under different operating systems.

1.

5.

SST License Manager is used as a security system for all products and hence user can have
different servers in the same network environment for different products.

Can have one server for various products installed in different client machines.
Can install both server/client in one computer.

Can have two different servers for one product by splitting the number of users (not applicable for
single user) and

Locating the server automatically in a large network environment is a time consuming process.

The procedure for setting the Environmental Variable “SSTLM” in the client machine under different
operating systems is listed below.

Windows 2000 (Server/Professional Edition) / Windows XP (Personal and Professional)

Open the “Control Panel” window through Start Menu->Settings->Control Panel.

Double-click on “SYSTEM?” icon as shown in left figure below.

B3 Control Panel - Il:llll System Properties

File Edit “ew Favarites Tools Help |ﬁ Ganera\l Nelwurkldenlificaliunl Haldwarel User Profiles

G Back - = - | Qsearch  [yFolders &% | FERLr S g i

~ Performance

Lddress I ) = Ga Ferformance aptions contral how applications uss memary,
= Control Panel J 6) which affects the speed of your computer.
TOTOeT T, T AN TIEN ] TIETTTED ;I
Controllers Extre... Options -
FPerformance Options. |
% @ %) r— Environment ' ariable:
. . r Environment variables tell your computer where to find certain
FKeyboard Licensing Mail Mouse Metwark, and (s d (v,
Dial-up Co...
."“‘ Erevironment Wariables.. |
4 9 @ a2
) ] ) — Startup and Recovery
Phone and  Power Options Printers Reegional Scanners and ’
d Options Cameras Startup and recovery options tell your computer haw to start
Modem .. P! — and what ta doif an error causes your computer to stop.
-
— -
\9: Startup and Recovery.. |
-
Scheduled  Sounds and =
Tasks Multimedia -
|Pr0vides system information and c| |@. My Camputer v (i I sl | £rpl |

Select the tab “Advanced” and press the button “Environmental Variables” as shown in right figure above.

Click the button “New” under the “User Variables” as shown in figure below.

Type “SSTLM” under the variable name prompt and key in the name or IP Address of the computer
where SST License Manager is installed (for e.g., info025 or 192.0.0.4) under the value prompt.

Press the button “OK” to complete the setting.
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Windows 7.0 or later

Open the “Control Panel” window through Start Menu > Control Panel as shown in left figure below.
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rights reserved

Service Pack 1
Get more features with 2
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Double-click on “SYSTEM” icon and then to “Advanced system settings” as shown on the figure right

above.

From the window, press the button “Environment Variables...”, you will see a window as shown in figure

right below.
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Type “SSTLM” under the variable name prompt and key in the Name or IP Address of the computer
where SST License Manager is installed (for e.g., info025 or 192.0.0.4) under the value prompt of User
variables or System variables

Press the button “OK” to complete the setting.
2.5 Product Key Generation

Before generating the Product Key, user has to make sure that the following requirements are met.
1. Ethernet card installed with proper driver files.

2. Static TCP/IP assigned to the server machine. If your machine (where SSTLM is installed) is
configured to obtain the IP Address automatically from a DHCP server, then user can disable the
feature of checking the IP Address by SSTLM by defining an environmental variable with name
“SKIPIP” and setting its value as “YES”. This feature can also be used when a product is installed
in a Laptop that is being used in a different network environment with different TCP/IP address.

3. Network cable plugged and connected to the network. Please note, if you generate a Product Key
without connecting to a network (network cable unplugged), then the license issued for that
Product Key could not be used when the network cable is plugged-in. On the other hand, the
license issued for the Product Key generated with network cable plugged-in can be used in
unplug mode too. Hence, it is always recommended to keep the network cable plugged-in before
generating the Product Key on both Desktops as well as Laptops (configured to use both in
standalone and network mode).

4. For XP operating system with service pack later than 1.0, open the TCP/IP port 12000 from the
Windows Firewall.

The procedure for creating the product key is explained in this section by assuming the name of the
module you own as “checkSTRESSPDMS”.

During the first run of the product, the client program communicates with the server computer and sends
request to check for the availability of the license to use the product.

The server (SST License Manger) checks for the availability of the license in the windows registry. If not
available, program automatically generates a new Product Key and send the same back to the client
machine. Client machine then pops up the same in a dialog box as shown in figure below.

ESl CHECKSTRESSPDMS License Activation E]|E_|@ K5l CHECKSTRESSPDMS License Activation

Client Name* |PBK Client Name*  [FBK

Company Name" |Irrfuplarrt Technologies Pvt. Lid. Company Name* |Hoplaﬂt Technologies Pvt. Lid.

Eroir |ip|ant@vsnl com Phone™ ‘+51-BI}-4D335555

Product Key |JASS7DFFFFFFDSAFFFFFSETFFFFFAZDFFFFFODIFFFFF63C66622818888

Activation Key |

Lic. Expiry Date M. of Users *fields are required

Get Activation Key | Close |

Email* |\plam@vsn\ com Phone* |+91-80-40336395

Product Key |I]A967DFFFFFFD5A. FFFFSB7FFFFFA2DFFFFFOD3FFFFFEICE6622818888

Activation Key |
Lic. Expiry Date Ne. of Users “fields are required

Mo | GetActivation Key | Close |

Showdetmils | Sendemail |

Enter the details as shown in the figure above and press the button “Get Activation Key”. This will get you
the Activation Key for Evaluation the product / Full license for paid users.

If you wish to send and email, press the button “More >>" and then “Send email”.
Press the “More >> and then “Show Details” if you wish to store the license details in a text file. Press the
button “Close” to close the dialog.

Note:
For receiving the Activation Key, please make sure that you have access to internet from your machine
and the TCP/IP port 12000 is not blocked by your hard / soft firewall.
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2.6 Installing the Activation Key
The Activation Key can be installed in two ways.

1. Using client module and
2. Using the Manage License Tool.

2.6.1 Using Client module

Launching the client product (InfoPlant product module), checks for the availability of the Activation Key
corresponding to the module and pops up “Security System” dialog box (in the client machine the
InfoPlant product being loaded) with provision to enter the “Activation Key” upon unavailability of the key.
Enter the Activation Key in the “Activation Key” text box and click the “Activate” button. Upon successful
installation, user gets a message “Activation Key successfully installed”.

2.6.2 Using Manage License Tool
a. Run the program “ManageLicense.exe” available in the installation directory of “SSTLM".

b. Select “Analyse Tool” from the menu “Tools” for server version or select “Analyse Tool” available
in the main menu of the InfoPlant product for standalone version.

c. From the dialog box as shown in figure below, select the product from the “Select Product” combo
box.

d. Select the check box “Install or Repair Activation Key”. This enables the text box below the check
box.

e. Paste the “Activation Key” in it and press the button “Install Key”. On successful installation, user
gets a message “Activation Key successfully installed”.

3 Analyse Tool

Select Product | | Analyse Key
I Install or Repair Activation Key Install Key

Save License
Delete License
System Info
Diagnose
Save Report
Clear

Borrow License
Close

2.7 Renewing/Re-Installing the License

Follow the steps a. through e. listed in 2.6.2 above to renew/re-install the license (Activation Key). Refer
SST License Manager User's manual for more details or Select the Option “Help->Renew/Reinstall
Activation Key”.
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3.0 Limitations

Limitations defined in this Chapter are generic in nature and is not specific to any Plant Design application
software. Limitations specific to each Plant Design application is listed in the corresponding Readme file
(*.pdf) supplied along with the checkSTRESS software for that Plant Design application.

The present version of the checkSTRESS has the following limitations.

3.1

3.2

3.3

In Case of unavailability of checkSTRESS material detail corresponding to Plant Design material
description (available in the neutral file), then program takes the Material information specified in the
first row of the material Mapping DB selected during transfer to checkSTRESS. Refer Appendix B for
more details. User can also modify the Material properties in checkSTRESS through Edit Layout-
>Misc->Materials.

If OD (outer diameter) or Thickness (Wall thickness) for an element is not available in the neutral file,
then OD and Thickness shall be extracted from the Mapping DB corresponding to the specified
Nominal Size for that element.

Note: Thickness corresponding to Standard Schedule (ANSI) is entered in the Mapping DB and
supplied with the standard product. User can change these values to suit their project requirement, if
necessary. Refer Appendix C for more details.

In addition to the above, user can modify the OD and Thickness of a component through Edit Layout-
>Misc->Sections.

The following items are currently not transferred from Plant Design to checkSTRESS at this time.
However, user can add these items in checkSTRESS through Edit Layout->Misc->Sections.

a. Corrosion allowance and Mill tolerance of the piping section and

b. Lining Density and Lining Thickness of the piping section.
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4.0 Reference

This section describes in detail, the methodology followed for transferring the piping components from
Plant Design software to checkSTRESS.

4.1 Loads

Temperature (Deg F or Deg C) and Pressure (psi or kg/cm2) entered in 3D Plant Design software is
transferred to checkSTRESS for all the elements. If the specific gravity of the fluid (with respect to water)
is specified during run time, the same will be transferred to checkSTRESS. If left blank then it will be set
as 0.0.

4.2 Pipe

Pipe from 3D Plant Design software is transferred as Pipe to checkSTRESS. OD and Thickness (in or
mm) is read from the Plant Design Database and transferred to checkSTRESS for each element. If OD
and/or Thickness are not available / entered in the 3D Plant Design software, then the program will read
the OD and / or Thickness from the Mapping DB corresponding to the Nominal Size specified in the 3D
Plant Design for that element. Material hame for each pipe element is read from the 3D Plant Design
Database the program then gets the material properties corresponding to the 3D Plant Design material
name through the Mapping DB and writes the same to checkSTRESS for that element.

4.3 Bend / Elbow

Bend/Elbow from 3D Plant Design software is transferred as “Bend” to checkSTRESS. The radius (in or
mm) of the bend is extracted from the database, if available otherwise; it is calculated as the distance
between the Near/Far end of the bend and Tangent Intersection Point divided by Tan (8 /2), Where 0 is
the included angle of the bend. The value thus obtained above shall be written to bend radius field in
checkSTRESS.

4.4 Valve

Valve from 3D Plant Design software is transferred as “Valve” to checkSTRESS. Dry weight of valve
(without Fluid weight [Ib or kq]) is read from 3D Plant Design Database and transferred to “Weight” field of
checkSTRESS Valve element.

4.5 Reducer

Reducer (Concentric and Eccentric) from 3D Plant Design software is transferred as Reducer to
checkSTRESS. The OD (in or mm) and Thickness (in or mm) obtained from the Arrive position shall be
written to “OD1” and “THK1” fields of checkSTRESS. On the other hand, the OD and Thickness obtained
from the Leave position shall be transferred to “OD2” and “THKZ2” fields in checkSTRESS.

4.6 Instrument

Instruments from 3D Plant Design software are transferred as “Rigid” element to checkSTRESS. Dry
weight (Ib or kg) of Instrument is read from 3D Plant Designh database and the same is transferred to
“Weight” field of the rigid element in checkSTRESS.

4.7 Flange

Flange from 3D Plant Design software can be transferred as “Pipe with Flange” or “Rigid element” to
checkSTRESS. If the user selects “Pipe with Flange” option from checkSTRESS dialog during run-time,
then the program creates a pipe for a length equivalent to length of flange and creates a Flange node at
the pipe end in checkSTRESS with flange type as “Weld Neck”. The OD and Thickness (in or mm)
corresponding to Flange Nominal Size is transferred to pipe in checkSTRESS. Dry weight of flange is
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read from 3D Plant Design database and the same is transferred to “Weight” field of the Flange Data
Type in checkSTRESS

On the other hand, If the user selects “Rigid element” option during run-time then, the program will
transfer the same as “Rigid Element” to checkSTRESS. Dry weight of flange is read from 3D Plant Design
database and the same is transferred to “Weight” field of the Rigid Element in checkSTRESS.

4.8 Olet

Olet from 3D Plant Design software is transferred as Pipe to checkSTRESS with a Branch SIF defined at
the intersection (i.e., where the branch pipe intersect the main run of the pipe).

4.9 Tee

Tee from 3D Plant Design software is transferred as three pipes connecting the near end & center, far
end & center and branch point & center with a Branch SIF (Welding Tee) specified at the center point of
the Tee. OD and Thickness read from the 3D Pant Design database for this component is transferred to
each checkSTRESS pipe fields thus created as mentioned above.

4.10 Three Way Valve

Three Way Valve from 3D Plant Design is transferred as “Three Rigid Elements” or “Three Pipes with one
Concentrated Mass at its Centre” to checkSTRESS by connecting the near end & center, far end & center
and branch end & center. From the section property, weight of fluid (kg/lb) is calculated and is added to
the dry weight (kg/lb) of Three Way valve read from 3D Plant Design database. The total weight thus
obtained is transferred to each rigid element in proportion to its length.

In the latter option, the dry weight of Three Way valve is transferred as weight of the Concentrated Mass
at the intersection of the three pipes.

4.11 Cross

Cross from 3D Plant Design software is transferred as four pipes connecting near end & center, far end &
center and two branch points & center with Branch SIF (Welding Tee) at the pipes intersection in
checkSTRESS. OD and Thickness read from the 3D Pant Design database for this component are
transferred to each pipe fields thus created as mentioned above.

4.12 Four way Valve

Four Way Valve from 3D Plant Design is transferred as “Four Rigid Elements” or “Four Pipes with one
Concentrated Mass at its Centre” to checkSTRESS by connecting the near end & center, far end & center
and two branch ends & center. From the section property, weight of fluid (kg/Ib) is calculated and is added
to the dry weight (kg/lb) of Four Way valve read from 3D Plant Design database. The total weight thus
obtained is transferred to each rigid element in proportion to its length.

In the latter option, the dry weight of Four Way valve is transferred as weight of the Concentrated Mass at
the intersection of the three pipes.

4.13 Material

Material name from Plant Design software is mapped to get the corresponding checkSTRESS material
and then transferred to checkSTRESS. Refer Appendix B for details.

User can also add/modify the Material properties in checkSTRESS through Edit Layout > Misc >Materials.
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4.14 Support

Support information (Location and its type) from Plant Design software can be transferred to
checkSTRESS in two ways viz.

a. With the use of mapping DB and
b. Without using Mapping DB
Refer Appendix D for details.

4.15 Thermal Anchor Movement (TAM)

Thermal Anchor Movement (TAM) values entered in global X, Y and Z directions at Equipment Nozzle
where the piping layout (selected for checkSTRESS) is connecting to. These values thus entered can be
transferred to checkSTRESS. TAM values should be defined in “mm” for Sl units and in “Inch” for English
units. If the TAM values are not available / entered in 3D Plant Design software at Equipment Nozzle then
they can be entered into checkSTRESS through Edit Layout option. i.e., Click Edit Layout then select
“Anchor” and select “Edit data” through Layout > Edit. From the dialog box shown, click on “Specified
Displacement” and enter the TAM values.

4.16 User defined Equipment Nozzle Allowable Loads

Equipment Nozzle Allowable Loads (forces and moments) provided by the equipment manufacturer or
calculated using Applicable codes / Finite Element Methods can be entered in global X, Y and Z
directions at Equipment Nozzle where the piping layout is connecting to. These values thus entered at the
Equipment Nozzle of the 3D Plant Design software can be transferred to checkSTRESS. Please note, the
force values should be entered in “Ib” for English units and in “N” for S| units. Similarly, the moment
values should be entered in “ft-Ib” for English units and in “Nm” for Sl units.

If allowable loads values are not entered / available in the 3D Plant Design software, then these values
can also be entered through Edit Layout > Misc > User Allowables. The allowables thus defined are
compared against calculated loads and shown / printed in Support Load Summary outputs (can be
viewed / printed through “Show Summary” option). If the calculated loads exceed the allowables, they are
highlighted in red.

4.17 Units

This section describes the units of measurement used to transfer the information from 3D Plant Design
software to checkSTRESS.

Length (Inches or mm)

Length related dimensions such as OD, Wall thickness, Insulation thickness, Bend radius and Nominal
Size from 3D Plant Design software are transferred as Inches or mm for English and Sl units respectively.

Temperature (Deg F or Deg C)

Temperature from Plant Design software is transferred as Deg F or Deg C for English / Sl units
respectively.

Pressure (entered as psi or kg/cm2 in Plant Design)
Pressure from Plant Design software is transferred as psi or bar for English / S| units respectively.
Mass or Weight (Ib or KQ)

Dry weight and Wet weight of components from Plant Design software are transferred as Ib or Kg for
English and S| Units respectively.
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Density (Ib/in3 or kg/m3)

Material Density, Insulation Density and Fluid Density from Plant Design software are transferred as Ib/in3
or Kg/m3 for English and Sl units respectively.

Translational Stiffness (Ib/in or N/mm)

Translational stiffness from Plant Design software is transferred as Ib/in or N/mm for English and Sl Units
respectively to CAEPIPE.

Rotational Stiffness (in-lb/deg or N-m/deq)

Rotational Stiffness from Plant Design software is transferred as Ib-in/deg or N-m/deg for English and Sl
Units respectively to checkSTRESS.

Force (Ib or N)

Force values from Plant Design software is transferred as Ib or N for English and Sl Units respectively to
checkSTRESS.

Moment (ft-lb or Nm)

Moment values from Plant Design software is transferred as ft-lb or Nm for English and SI Units
respectively to checkSTRESS.
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Appendix A

3D Plant Desigh—-to—checkSTRESS Component Mapping

All components available in Plant Design software are mapped with checkSTRESS component. The

details are tabulated below.

Type of Component in Type of Component in checkSTRESS Keywords used in
Plant Design software Neutral File
Pipe Pipe Pl
Valve Valve VA
Flange Rigid Element / Pipe with Flange FL
Instrument Rigid Element RB
Reducer Concentric Reducer Concentric RD
Reducer Eccentric Reducer Eccentric ER
Cross Four Pipes with Branch SIF (Welding
CR
Tee)
Elbow / Bend Bend EL
Three way Valve Three Rigid Elements / Three Pipes with
3w
Concentrated Mass
Four way Valve Four Rigid Elements / Four Pipes with
AW
Concentrated Mass
Tee Three Pipes with Branch SIF (Welding
T™W
Tee)
Olet Pipe with Branch SIF (Weldolet) TO
Support Restraint Data Type(s) HA
Hanger Hanger Data Type HA

Note: Refer Plant Design software specific Readme file (.hlp) supplied with the product for detailed

component mapping.
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Appendix B

Material

Material name for each element is read from the 3D Plant Design database and is written to the neutral
file. The program then gets the checkSTRESS material information corresponding to 3D Plant Design
material information as follows.

a. checkSTRESS reads the Material Mapping DB file name from the table “code” available in
Codedb.mdb corresponding to the Analysis Code specified in the form during transfer.

b. Gets the checkSTRESS Material properties from the Material Mapping DB (thus obtained above)
corresponding to 3D Plant Design material description.

In case of unavailability of checkSTRESS material property corresponding to 3D Plant Design material
description available in the transfer file, then program reads the checkSTRESS Material property
specified in the first row of the Material Mapping DB (obtained above) and transfers the same to
checkSTRESS.

Material DB Modification / Creation

User is allowed to create their own material table and can use the same by modifying/adding the name of
Material Mapping DB file name in table “code” of “Codedb.mdb” supplied along with this software. This
table contains four fields viz. PdCode, KpCode, KpMat and KpSect. The first field “PdCode” contains the
name of Piping Codes that can be specified in 3D Plant Design Software. The second field “KpCode”
contains the name of Piping Codes that are available in checkSTRESS corresponding to Analysis Code
defined in 3D Plant Design Software. Third field “KpMat” defines the name of the Material DB file to be
used (to get the CAEPIPE Material property) during transfer. Fourth field “KpSect” defines the name of
the Schedule Table to be used (to extract OD and Thickness if not available in the Neutral file for an
element) during transfer. Please note, the Material DB must exist before it is used in the Codedb.mdb.
The procedure for creating a Material DB and modifying the Codedb.mdb is listed below.

a. Copy the existing file (B311.mdb) and rename the file with a desired name by pasting it to the
directory where the source file was stored.

b. The newly created DB contains four tables viz. MaterialE, MaterialS, MdetailE and MdetailS. The
MaterialE and MdetailE table in the DB are used to define material properties in English units
whereas MaterialS and MdetailS tables are used to define the material properties in Metric units.

c. Enter the Plant Design Material description (available in 3D Plant Design Database) into the field
“‘MatName” of “MaterialE/MaterialS” table and enter the engineering property of the material such
as Density, Nu, Joint factor, etc., depending upon the availability of the information in the code
selected and leave the rest of the fields as “None”. For example, the fields Tensile, CircFactor
and Yield is not valid for B31.1 and hence it should left as “None”.

d. Enter the Temperature related property such as Young’s Modulus, Alpha, Allowable, etc., into
“MDetailE/MdetaiS” table by expanding it using the button “+”. Fill the fields that are relevant to
the Material Code selected and leave the rest as “None”.

e. Modify the contents of each table with new values and save the DB. Fill the table fields with the
appropriate values available depending upon the type of piping code. Other fields can be left as
“None”.

f.  After successful creation of material Mapping DB as explained above in steps a to e, open the DB
codedb.mdb and enter the name of the Material DB file thus created above in the field “KpMat”.
For example, if you have created your own material Mapping DB file corresponding to B31.5 as
B315.mdb, then enter the name of the file (B315.mdb) in the field “KpMat” as “B315” where the
value of the field “PdCode” is equal to B31.5 and then enter the corresponding checkSTRESS
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Section details table name in the field “KpSect”’. A sample “Code” mapping DB with Material DB is
given below for reference.

Sample “Code” DB

PdCode KpCode kpMat | Kpsect
ASME CLASS2(19580) [ASME B311 STDsch
ASME CLASS2(1986) | ASME-GE B311 STDsch
ASME CLASS2(1992) | ASME-S2 B311 STDzch
B31.1 B311 B311 STDsch
B31.1(1967) B311-67 B311 STDsch
B31.3 B313 B313 STDs=ch
B31.4 B314 B314 STDsch
B31.5 B315 B315 ST0sch
B31.58 B315 5315 STDsch
ES806 ES806 B311 STDzch
CODETI[1995) SMCT B313 STDsch
Default B311 B311 STDsch
EN13480 EUROPEAN EN13480 [5TDsch
Morwegian(1983) NORVWEGIAN-83 [B313 STDsch
Maorwegian(15990) NORYWEGIAN-80 [B313 =TD0zsch
RCC-h(19585) RCC-h B311 STDsch
stoomwezen(1954) STOOMYWEZEN |B311 =T0sch
Swedish({1973) SWEDISH B311 STDsch
Z18301990) Z183 B313 STDsch
Z184(1992 Z184 B313 STDzch

Fields in Code DB Table:

PdCode - Name of the Piping Code than can be specified in Plant Design Software.
KpCode - Analysis code corresponding to Plant Design Code.

KpMat - Material DB name from where the material details are specified.

KpSect - Section DB name from where the Schedule details are specified.
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Sample “Material DB” (B315.mdb)

Sample Table “MaterialE” for English Units

Index MatName Density | Nu | JointFactor | MaterialType | Tensile | CircFactor | Yield
+ 1] A53-A 0.283 0311 Cs Mone Mone Mone
+ 2| AL3-B 0253 031 [ Mong Mong Mong
+ 3| AT06-A, 0253 031 [ Mone Mone Mong
+ 41 A106-B 0253 031 [ Mone Mone Mong
+ o A106-C 0.283 0311 C3 Mone Mone Mone
+ Bl API-SL-A 0.283 0311 Cs Mone Mone Mone
+ 7| API-GL-B 0253 031 [ Mone Mone Mong
+ A A312-TP304 0253 031 AS Mone Mone Mong
+ 9 A312-TP304L 0.283 0311 Ao Mone Mone Mone
+ 10| MonelB165-Annealed 0.283 0311 C3 Mone Mone Mone
+ 11| CopperB42-Annealed 0283 [0D3])1 CA Mone Mone Mone
+ 12| CopperB42-Drawn 0283 031 CC MNone MNone Mane
+ 13[RedBrass-B43 0253 031 CA, Mone Mone Mong
+ 14 Aluminum-B241-A96061TE |0.2253 0311 AL Mone Mone Mone
+ 15| Aluminum-B241-A96063T6 |0.2583 0311 AL Mone Mone Mone

Sample Table “MdetailE” for English Units

Fields in each table and their descriptions are given below in detail.

Fields in MaterialE Table:

Index - Unique Material Id

MatName - Material Name

Density - Density of the Material in English units
Nu - Poisson Ratio

JointFactor

MaterialType - Type of Material
Tensile - Tensile Strength
CircFactor - Circular Factor
Yield - Yield Strength

- Joint Factor of the Material
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Sample Table “MaterialE” for English Units

MatName | Temperature E Alpha | Allowable | Yield | Rupture | Design | Proof| fh | fCR
k1 05-A, -20 2.99EH17 [5.89E-06 12000 Mone |Maone Mone |Mone |Mone [Maone
A106-4, 70 295EH17 |6.08E-06 12000 Morne |Mone Maone Mone |Mone [Mone
A106-A 100 2 93EH)Y [6.14E-06 (12000 Mone [Mone Mong Mone [Mone |Mone
A006-A 300 2 83EH]Y [6.8BRE-0R (12000 Mone [Mone Mone Mone [Mone |Mone
A106-A, 350 2 80E+H17 |G6.85E-06 (12000 Mone |Mone Mone Mone |Mone [Mone
A006-A 400 2 77EHYY |6.82E-06 (12000 Mone [Mone Mone Mone [Mone |Mone
A006-A 160 2MMEHY (6.24E-06 (12000 Mone [Mone Mone Mone [Mone |Mone
A06-4, 200 288E+17 |6.35E-06 (12000 Mone |Mone Mone Mone |Mone [Mone
A006-A 260 2 86EHYY (6.R2E-0R (12000 Mone [Mone Mone Mone [Mone |Mone
A106-B 300 2.83EHI7 |B.aaE-06 15000 Morne |Mone Maone Mone |Mone [Mone
A106-5 350 2 B0EHYY [6.8B5E-06 [15000 Mone [Mone Mong Mone [Mone |Mone
A106-5 400 2 77EHYY |6.82E-06 [15000 Mone [Mone Mone Mone [Mone |Mone
A106-B -20 2 99E+H17 |5.89E-06 (15000 Mone |Mone Mone Mone |Mone [Mone
A106-5 70 2 95EH)Y [6.0BE-06 [15000 Mone [Mone Mone Mone [Mone |Mone
A106-5 100 2 93EH)Y (6. 14E-06 [ 15000 Mone [Mone Mone Mone [Mone |Mone
A106-B 150 291EH7 |6.24E-06 (15000 Mone |Mone Mone Mone |Mone [Mone
A106-5 200 2 8REH]Y [6.35E-06 [15000 Mone [Mone Mone Mone [Mone |Mone
A106-5 260 2 86EH]Y [6.B2E-06R (15000 Mone [Mone Mone Mone [Mone |Mone

Fields in MDetailE Table:

MatName - Material name
Temperature - Material Temperature
E - Young’s Modulus
Alpha - Alpha value for material
Allowable - Allowable Loads

Yield - Yield Strength

Rupture - Rupture Stress

Design - Design Factor

Proof - Proof Stress

fh - Allowable Stress at Maximum Temperature
fCR - Allowable Creep Stress

Material properties for six piping codes viz B31.1, B31.3, B31.4, B31.5, B31.8 and EN13480 are available
in the DB (i.e. B311.mdb and B313.mdb).

23



Modification of “Config.ini” File

Material Mapping DB’s and Support Mapping DB’s are stored in the Application directory of the Product.
The customized Material Mapping DB’s and Support Mapping DB’s can be shared among the users of the
product by copying these files in a shared location and modifying the “config.ini” file to point to the new
path.

For clarity, “config.ini” file contains the path of the Material Mapping DB’s and Support Mapping DB’s. By
default, this will point to the application directory. Copying these files to a shared location and modifying
the path in the “config.ini” to reflect the new location will help users to share the customized DB’s. The
content of the file is listed below for reference.

[Config]

Product Name=checkSTRESS

Product Type=Server Version

Materials DB=

Code DB=

Support_DB=

leaving the above fields empty will use the default path

Assuming the Material Mapping DB’s, Code DB and Support DB are stored in the shared location DBS of
machine “InfoP025”, modify the Materials_DB, Code_DB and Support_DB as follows.

[Config]

Product Name=checkSTRESS

Product Type=Server Version

Materials DB=|InfoP025|DBS

Code DB-=lInfoPo25|DBS

Support_DB=lInfoP025|DBS

leaving the above fields empty will use the default path

Warning: Care should be taken while entering the fields of the CodeDb.mdb and the Material
Mapping DB as the wrong entry or leaving the field empty may lead to malfunction of the software.
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Appendix C

Schedule Table

The table “code” in Codedb.mdb contains a field named “KpSect” to specify the schedule to be used
during transfer. In case of unavailability of OD and/or thickness values in transfer file, translator reads the
OD and/or thickness from the standard schedule table and transfers the same to checkSTRESS. In case
the value of the field “KpSect” is not defined or left empty in the table, then the program will use the
“Standard Schedule (STD)” for ANSI standard by default.

Schedule Table Creation / Modification

The procedure for creating the user defined Standard Schedule Table is listed below

1. Copy the table “STDsch” and then paste it as new table in the same “Codedb.mdb” by specifying
a new name for the table.

2. Modify the contents of the table with the new values.

3. Open the table “Code” and then enter the “KpSect” field with the name of the table created above
corresponding to the “PdCode”. For e.g. assuming the name of the new Standard Schedule table
created as “Sch40” corresponding to “B31.1” PdCode, change the value of field “STDsch” as
“Sch40”.

PdCode KpCode kpMat | Kpsect
B31.1 B311 B311 =10sch

Sample Schedule Table

NPD.E | NPDM| OD | THK |
0125 |4 |i0.287 17272
0.25 5 13716 |2.2352
0,375 |10 17145 |z.3114 |
0.5 15 21336 |2.7686
0.75 20 2667 |2.8702
1 Z5 33401 |3.3782
1.25 3z 42,164 |3.556
15 40 48.26  |3.683
2 S0 60325 |3.9116

Fields in standard schedule table and their descriptions are given below in detalil.

NPD_E - Nominal Piping Diameter in Inches
NPD_M - Nominal Piping Diameter in Millimeters
oD - Outside Diameter in mm

THK - Wall thickness in mm

Warning: Care should be taken while filling the fields of the Schedule DB as the wrong entry
may lead to malfunction of the software.
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Appendix D

Supports

Support information (Location and its type) from Plant Design software can be transferred to
checkSTRESS in two ways viz.

1. With the use of mapping DB
2. Without using Mapping DB

With the use of mapping DB

The support details (entered via attributes) and its location specified in the Plant Design software are
transferred to checkSTRESS. The values of the attributes filled at support locations shall be in
accordance with the values specified in the field #1 of tables “Zvertical” and “Yvertical” of
“SupportType.mdb” built into the application. The values from field #1 of table “Zvertical” shall be referred
and entered at the support locations (via attributes), if the Global Vertical Axis to be used in the Stress
Model is “Z”. On the other hand, values from field #1 of table “Yvertical” shall be referred and entered at
the support locations (via attributes), if the Global Vertical Axis to be used in the Stress Model is “Y”.

Fortunately, the values entered/available in the field #1 of tables “Zvertical” and “Yvertical” are kept
identical, because most Plant Design software always consider the vertical direction as Z-axis. On the
other hand, pipe stress engineers in different parts of the world use either Z-axis as vertical or Y-axis as
Vertical. So, the values entered in the field “KpSupport” are different for “Zvertical” and “Yvertical’.
Program always uses the value entered in the field “KpSupport” corresponding to the value entered in
field “PdSupport”, for its stress model file generations.

User can modify the values available in the field “PdSupport” of tables “Zvertical” and “Yvertical” to suit
their requirements. It is recommended to keep the values entered in the filed “PDSupport” of tables
“Zvertical” and “Yvertical” identical as much as possible. This will help to avoid the user in
reentering/changing the values at support locations for different Global Vertical Axis.

In case, the CAEPIPE support information corresponding to the attribute value entered in the Plant
Design is not available/defined in the mapping DB, then the translator skips that support at the location.

Without using mapping DB

Using this option, user can define the support conditions (boundary conditions) in checkSTRESS
equivalent to the Physical Support configurations from Plant Design software. In such cases, the mapping
DB will not be used for transferring the support information. Refer the sections listed below for details on
entering the support information in Plant Design software.

Hangers

Hangers can be transferred from Plant Design software to checkSTRESS by specifying the following at
support locations.

Syntax:

Hanger(Type of Hanger:Number of Hangers:Allowable Travel Limit[in or mm]:Load Variation[%)]:Short
Range)

Example:
Hanger(Spring Supports:2: :20:1)

Note: Allowable Travel Limit option is not enabled at this time. Please skip that field while entering the
values.
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Rod Hanger

Rod Hangers can also be transferred from Plant Design software to checkSTRESS by specifying the
following at support locations.

Syntax:

Hanger(ROD:Number of Hangers)
Example:

Hanger(ROD:1)

Constant Support

Constant Support can be transferred from Plant Design software to checkSTRESS by specifying the
following at support locations.

Syntax:

Hanger(CONSTSUPPORT:Number of Hangers)
Example:

Hanger(CONSTSUPPORT:3)

User Hanger

User specified Hangers could also be transferred from Plant Design software to checkSTRESS by
specifying the following at support locations.

Syntax:
USERHANGER(Number of Hangers:Spring Rate[ib/in or N/m]:Cold Load:Hot Load)
Example:

For example one number of user hanger with spring rate of 1E8N/m, and hot load 1000 can be specified
as follows,

USERHANGER (1:1E8: :1000)
Guide

Guide Restraint can be transferred from Plant Design software to checkSTRESS by specifying the
following at support locations.

Syntax:
GUI(Stiffness[ib/in or N/m]:Gap[in or mm]:Friction Coefficient)
Example:

Guide with Rigid stiffness, 50mm gap between guide and pipe and 0.3-friction coefficient can be specified
as follows,

GUI(R:50:0.3)
Skewed Restraints

Skewed restraint(s) with different directional vectors can be transferred from Plant Design software to
checkSTRESS by specifying vector details with the following at support locations.

Syntax:
SKEW (VecX:VecY:VecZ:Stiffnessib/in or N/m]:Gap[in or mm]:Friction Coefficient:Type)
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Example:
SKEW(0.707:0.707:0.707:1E10: : :R)

Note: Gap and Friction Coefficient options are not enabled at this time. Please skip those fields while
entering the values.

Double acting Translational Restraints

Double acting Translational restraint(s) can be transferred from Plant Design software to checkSTRESS
by specifying the following at support locations.

If Double acting Translational restraint(s) are specified with Stiffness and Gap then transferred as
“Anchor” data type with stiffness specified in that restraint will be assigned to corresponding translational
stiffness to the Anchor and Gap specified in that restraint will be assigned to corresponding translational
Displacement to the Anchor.

If Double acting Translational restraint(s) are specified without Stiffness and Gap then transferred as
Restraint Data type.

Syntax:
Translational Restraint Type(Stiffness[ib/in or N/m]:Gap[in or mm)
Example:

Double acting Translational restraints in X and Y directions with stiffness 1E+12 Ib/in and gap of 0.10 in
can be transferred by specifying the support attributes as, X(1€12:0.10);Y(1e12:0.10).

Please note, Stiffness, Gap and Friction Coefficient are optional values. If not defined, then transferred as
Restraint Data type i.e. X and Y restraint to CAEPIPE. If Stiffness or Gap, any one value is not specified
then the Stiffness and Gap shall be transferred to checkSTRESS as 1E+12 Ib-in (RIGID) and 0.0
respectively.

Double acting Rotational Restraints

Double acting Rotational restraint(s) can be transferred from Plant Design software to checkSTRESS by
specifying the following at support locations.

If Double acting Rotational restraint(s) are specified with Stiffness and Gap then transferred as “Anchor”
data type with stiffness specified in that restraint will be assigned to corresponding rotational stiffness to
the Anchor and Gap specified in that restraint will be assigned to corresponding rotational Displacement
to the Anchor.

Syntax:
Rotational Restraint Type(Stiffness[lb/in or N/m]:Gap[in or mm)])
Example:

Double acting Rotational restraints in X and Y directions with rotational stiffness 1e12 Ib-in/deg and gap of
0.10 rad can be transferred by specifying the support attributes as, RX(1E12:0.10);RY(1E12:0.10).

Please note, Stiffness and Gap are optional values. If not defined, then the Stiffness and Gap shall be
transferred to checkSTRESS as 1E+12 Ib-in/deg (RIGID) and 0.0 respectively.

Limit Stop

Limit stop can be transferred from plant design software to checkSTRESS by specifying the following at
support locations. Directional components are must while specifying limit stop.

Syntax:
LIM(Stiffness[Ib/in or N/m]:Gap[in or mm]:Friction Coefficient:Xcomp:Ycomp:Zcomp)
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Example:

Limit stop in Y direction with Rigid stiffness and gap of 50 mm with coefficient of friction 0.2 can be
transferred by specifying the support attribute as LIM(RIGID:50:0.2:0:1:0).

Please note Rigid stiffness means 1E+12 N/m will be taken in checkSTRESS. The Gap value specified
will be assigned to Lower limit of the limit stop and Upper limit is assigned as ‘None’ in checkSTRESS.

Single acting Translational Restraints

Single acting Translational Restraints are transferred as Limit stop to checkSTRESS. If the user specify

both single acting restraints (i.e., “+” and “-“) for same direction then the Gap value of “+” directional
restraint is assigned to Lower limit and the Gap value of “-“ directional restraint is assigned to Upper limit
of the Limit stop.

If one (i.e., “+” or “-“) directional restraint is specified then the Gap value will be assigned to lower limit or
upper limit depends upon the sign and other limit will assigned as “None”. By following the syntax
mentioned below, user can transfer the Single acting restraints to checkSTRESS.

Syntax:
Single Acting Restraint Type(Stiffness[lb/in or N/m]:Gap[in or mm]:Friction Coefficient)
Example:

For transferring the Single acting Translational Restraints in X direction enter the attribute of Plant Design
Support location as

+X(1e10:35:0.25);-X(1e10:25:0.25)

Snubber

Snubbers can be transferred from Plant Design software to checkSTRESS by specifying the following at
support locations.

Syntax:

Types of Snubber(Stiffness([lb/in or N/m])
Example:

YSNB(1E10) or ZSNB(1E6)

Skewed Snubber

Skewed Snubbers can be transferred from Plant Design software to checkSTRESS by specifying the
following at support locations.

Syntax:

SNB(VecX:VecY:VecZ:Stiffness[lb/in or N/m])

Example:

Skewed Snubber with stiffness 1E+9 can be specified with directional vectors as follows,
SNB(0.707:0:0.707:1E9)
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Force / Moment

Force and Moments can be transferred from Plant Design to checkSTRESS by specifying the following at
support locations.

Syntax:

FORCE(Fx:Fy:Fz[Ib or NJ])

MOMENT (Mx:My:Mz[Ib-in or Nm])

Example:

1000N Force acting in Y direction can be specified as follows
FORCE(0:1000:0)

500Nm Moment acting in Z direction can be specified as follows
MOMENT(0:0:500)

Skewed Restraint

Skewed Restraints can be transferred from Plant Design software to checkSTRESS by specifying the
following at support locations.

Syntax:
SKEW (VecX:VecY:VecZ:Stiffness[Ib/in or N/m]:Gap[in or mm]:Friction co effiecient:Type)

Note: Gap and Friction co efficient is not enabled this time. Please skip those fields while entering the
values.

Example:

SKEW(1:0:0.707:1E11: : :R) or SKEW(0:1:0:RIGID: : : T)

Threaded Joint

Threaded Joint can be assigned to nodes by specifying the following at support locations.
Syntax:

TJOINT

User SIF

User SIF can be assigned for a node by specifying the following at support locations in Plant design
software.

Syntax:
UserSIF(Value)
Example:
UserSIF(100)
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Appendix E

Possible Restraints Types and Hangers

Particulars

Syntax

Example

Anchor

Anchor

ANC(Stiffness:Gap)

ANC or ANC(1E12:0.0) or
ANC(1E12)

Double Acting
Translational Restraints

X X(Stiffness:Gap) X or X(1E12) or X(1E12:25)
Y Y(Stiffness:Gap) Y or X(1E10) or Y(R:50)
Z Z(Stiffness:Gap) Z or Z(RIGID) or X(RIGID:35)

Double Acting Rotational
Restraints

RX RX(Stiffness:Gap) RX or RX(1E12) or RX(1E12:0.0)
RY RY(Stiffness:Gap) RY or RY(R) or RY(1E12:25)
RZ RZ(Stiffness:Gap) RZ or RZ(RIGID) or RZ(R:50)

Double Acting Snubbers

XSNB XSNB(Stiffness) XSNB or XSNB(1E12)
YSNB YSNB(Stiffness) YSNB or YSNB(R)
ZSNB ZSNB(Stiffness) ZSNB or ZSNB(RIGID)

Skewed Snubbers

SKEW (VecX:VecY:VecZ:Stiffness)

SKEW(0.707:0.0:0.707:1e12) or
SKEW(0:0:0.707:RIGID)

Single Acting
Translational Restraints

Restraint Type(Stiffness:Gap:Friction

+X(1E10:35:0.35) or

+Xand -X Co-efficient) _X(RIGID:25)

+Y and -Y Restraint Type(Stiffness:Gap:Friction +Y(R:50:0.2) or
Co-efficient) -Y(:15:0.28)

+7 and Z Restraint Type(Stiffness:Gap:Friction +Z(:45) or —Z(RIGID::0.26) or
Co-efficient) +Z(:25)

Double Acting Limit
Stops

LIM

LIM(Stiffness:Gap:Friction Co-
efficient:Xcomp:Ycomp:Zcomp)

LIM(1E12:30::0:1:0) or
LIM(RIGID:50:0.4:0.707:0.707:0)

Skewed Restraints

Skewed Restraints

Skew(VecX:VecY:VecZ:Stiffness:Gap:
Friction coefficient:Type of Restraint)

Skew(0.707:0.707:0.0:1E12: : :R)
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Guide

GUI

GUI(Stiffness:Gap:Friction Co-
efficient)

GUI or GUI(1E12) or GUI(R:50)
or GUI(RIGID:25:0.25)

Spring Hangers

Hanger

Hanger(Type:No.of Hangers:All.Travel
Limit:Load Variation:Short Range)

Hanger or Hanger(Grinnell :1) or
Hanger(Grinnell :1: :25) or
Hanger(Grinnell :1: :25:1)

Constant Support Hanger

Hanger(CONSTSUPPORT:No.of
Hangers)

Hanger(CONSTSUPPORT) or
Hanger(CONSTSUPPORT:2)

Rod Hanger

Hanger(ROD:No. of Hangers)

Hanger(ROD) or
Hanger(ROD:1)

User Hangers

User Hangers

UserHanger(Spring Rate:No.of
Hangers: Cold Load:Hot Load)

UserHanger(200:1:1131) or
UserHanger(200:1:0.0:1088)

Force / Moment

Force

Force(Fx:Fy:Fz)

Force(1200:800:0.0)

Moment

Moment(Mx:My:Mz)

Moment(0:500:250)

Threaded Joint

Threaded Joint

TJOINT

TJOINT

User SIF

User SIF

UserSIF(Value)

UserSIF(100)

Note:

1. Stiffness, Gap and Friction Coefficient are optional values. If not defined, then it will be
transferred as 1E12 Ib/in i.e. RIGID, 0.0 in, and 0.0 respectively to checkSTRESS.

2. For Sl units, the Stiffness and Gap should be specified in N/mm and mm respectively.

3. The Hanger Type, Number of hanger, Allowable Travel Limit (not applicable at this time), Load

variation and Short range are optional value. If the above information are not defined, then the

program will assume the following

a. Hanger Type = Hanger Type is selected/Specified in the Plant Design to checkSTRESS

form.

b. Number of Hanger =1

c. Allowable Travel Limit = 0.00 (not applicable at this time)

d. Load Variation =25 %

e. Shortrange = 1 (Use short range)

32




For Sl units, the Spring Rate, Cold Load and Hot Load should be specified in N/mm, Kg and Kg

respectively.

For defining more than one support at each support location use “” in between support

definitions.

“,n

Hanger Types

ABB-PBS

Fee & Mason

Nordon

Basic Engineers

Flexider (30-60-120)

NPS Industries

Berger-Paterson

Flexider (50-100-200)

Piping Services

Bergen-Paterson (L)

Fronek

Piping Tech & Products

BHEL Hyderabad Grinell Power Piping

BHEL Trichy Hydra f‘z"‘g)‘"’a Tekki(30-60-
Borrello Lisega Sanwa Tekki(85-170)
Carpenter & Paterson Mitsubishi (30-60-120) Sarathi

Comet Mitsubishi (80-160) Spring Supports
Corner & Lada Myricks SSG

Dynax NHK (30-60-120)

Elcen NHK (80-160)
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Appendix F

Sample Problems and Solutions using checkSTRESS

This Appendix provides a few sample layouts (specifically, Samplel, Sample 2, Sample 3 and Sample 5)
to illustrate how bends, offsets, loops, axial restraints and/or intermediate anchors are used to reduce
thermal stresses in piping (and resulting nozzle loads).

Sample 4 and Sample 5 illustrate how piping can be supported by spring hangers and resting steel
supports to comply with the code requirements for sustained loads.

The CAEPIPE model files created using checkSTRESS for the sample problems listed in Appendix F are
stored in the directory checkSTRESS installation_path\Samples for reference.

Sample: 1 (Loop_00 and Loop_01)

This problem illustrates the use of expansion loops to reduce thermal stresses.

A 8" NB Schedule 80 pipe (see Fig. 1A) connects two equipment at nodes 10 and 30 with an offset of 4’
(i.e., e%ual to distance between nodes 20 and 30). The pipe is of A53 Grade A carbon steel and is heated
to 300 " F.

Pipe between nodes 10 and 20 grows thermally to the right towards node 20, while pipe between nodes
30 and 20 grows up towards node 20, as illustrated in Fig. 1B.

This thermal deformation generates large thermal stresses (orange and red zones) in the bend at node
20 and at anchor node 30, as shown in Fig. 1C.

Fig.1D shows a revised layout with a loop, introducing 2 additional bends at nodes 14 and 18, thereby
making the layout more flexible. So, thermal growth of X-directional pipes between nodes 10 and 14 and
then between 18 and 20 as well as the growth of Z-directional pipe between nodes 30 and 20 are
absorbed by the 3 bends at nodes 14, 18 and 20.

The corresponding stress contour plots for thermal and sustained load cases are shown in Fig.1E and
Fig. 1F, confirming code compliance.

FE: CheckStress : Graphics - [D:\CheckStress\MBF\Loop_00.res ()]
File Wiew Options Window Help

BE @G&RAKQ O

510 ------ - 20

Fig. 1A. Layout with Node Numbers
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[D:ACheckStress\MBF\ oop. 00.res ()]

FE CheckStress : Deflected shape: Expansion (11)

File Wiew ©Cptions Window Help

|~

Fig. 1B Thermal Deformation Plot

FE CheckSiress : SE f SA - [D:\CheckStress\MBF\L.oop_00.res ()]

Options  Window  Help

a Iewll QAR O

. 1.00

0.75
0.50

0.25

I 0.00

|~

|
| £

Fig. 1C Thermal Stress Contour Plot
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I CheckStress : Graphics - [D:\CheckStress\MBF\Loop_01.res ()]

File Wiew Options Window Help

5 EE@RRARARQ O

L

|A

Fig. 1D Revised Layout with Node Numbers

FE CheckSiress : SE f SA - [D:\CheckStress\MBF\L.oop_01.res ()]

File Wiew ©Cptions Window Help

5 BE HARARQ O

. 1.00
0.75
I 050
075
I 0.00

|~

|~

|

Fig. 1E Thermal Stress Contour Plot
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FE CheckStress : SL / SH - [D:WCheckStress\MBF\ oop_01.res ()]

File Wiew ©Cptions Window Help

S HE BRAKAKX O
. 1.00

0.75

- 0.50

0.25

l 0.00

|+

|

Fig. 1F Sustained Stress Contour Plot
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Sample: 2 (IntermediateAnchor 00 and 01)

This system shown in Fig. 2A is made of 3 pipe sizes, 4” NB Schedule 40 between the anchor node 10
and the first reducer starting at node 50, 6” NB Schedule 40 between the first reducer and the second
reducer ending at node 90, and 8” Schedule 40 between the nodes 90 and anchor node 130. The system
temperature is 470°F.

Since the loop between nodes 10 and 40 is much more flexible (as it is made of 4” NB pipe) than the loop
between nodes 100 and 130, the straight pipe between nodes 40 and 100 will thermally grow mostly
towards the 4” NB loop, as shown in Fig. 2B, straining the pipe between nodes 10 and 40; this, in turn,
produces large thermal stresses (i.e., orange and red zones) in the 4” NB loop and at anchor node 10, as
observed in Fig. 2C. In other words, the thermal growth of pipe between nodes 40 and 100 is mostly
absorbed by the 4” NB loop and very little by the 8" NB loop, defeating the very purpose of the 8" NB
loop.

In order to alleviate thermal stresses in the 4” NB loop, introduce an intermediate anchor at node 95
immediately after the second reducer, so that the thermal growth of straight pipe from node 95 to node
100 is absorbed by the 8” NB loop, while the thermal expansion of straight pipe between nodes 40 and 95
is absorbed by the 4” NB loop, thereby making both loops achieve their intended purpose. The
corresponding thermal displacement and thermal stress contour plots are given in Fig. 2D and Fig. 2E
respectively.

Fig. 2F confirms that for the deadweight of piping under operating condition, the present configuration
with only two equipment nozzles at nodes 10 and 130 and an intermediate anchor at node 95 safely meet
the code stress requirement for sustained load.
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Fig. 2A Layout with Node Numbers
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Sample: 3 (AxialSupport 00 and 01)

This problem shows how axial restraints (i.e., supports that prevent movement in the pipe axial direction)
can be effectively used to direct thermal growth towards expansion loops and to split thermal growth in a
line such that the two piping portions grow in opposing directions.

Fig. 3A shows the same problem as in Fig. 2D, with a 6” NB branch line added at the welding tee at node
70 (i.e., from node 70 to node 240).

The deformed geometry for thermal load is shown in Fig. 3B, where it is observed that the tee node 70
does not move up in +Y-direction. Since the intermediate anchor at node 95 restraints the vertical riser
(between bend node 220 and tee node 70) from thermally growing upward towards node 70, this riser
grows downward producing large bending moments and stresses at and around equipment nozzle at
node 240; in addition, since the upward growth of this vertical riser is effectively restrained at the tee node
70 due to presence of intermediate anchor at node 95, large localized thermal stress is generated at the
welding tee. This is observed in the thermal stress contour plot given in Fig. 3C.

Fig. 3D shows the same piping system with the intermediate anchor replaced by two axial restraints; the
axial restraint in the horizontal line at node 95 splits and directs its thermal growth towards the 4” NB and
8” NB loops and does permit the horizontal line to move up in +Y-direction at tee node 70, whereas the
axial restraint at node 210 splits the thermal growth of the vertical riser between nodes 220 and 70. From
the thermal deformation plot given in Fig. 3E, it is observed that such that much less forces and moments
and hence stresses would be generated at the equipment nozzle node 240 and welding tee node 70. Fig.
3F and Fig 3G show the thermal stress and sustained stress (in this case sustained stress is due to only
deadweight as pressure is zero) contour plots, confirming code compliant system for both loading cases.
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Fig. 3A Layout with Intermediate Anchor at Node 95

42



File Wiew ©Cptions Window Help
v A
z A/L\x
ul D —_—
~ s 2
< | >

Fig. 3B Thermal Deformation Plot

FE CheckStiress : SE / SA - [D:\CheckStress\MBF\AxialSupport_00. res ()]
File Wiew ©Cptions Window Help

|~
|

| £

Fig. 3C Thermal Stress Contour Plot

43



FE CheckStress : Graphics - [D:¥CheckStress\MBFWAxialSupport_01.res ()]

File Wiew ©Cptions Window Help

S MEE BRKAKX O

12

|+

I >

Fig. 3D Layout with Axial Restraints at Node 95 and 210

FI* CheckStress : Deflected shape: Expansion (11) - [D:¥CheckStress\MBF\AxialSupport_01.re... .

Eile Yew Options ‘Window Help

aﬂl@@@&o

S
|
I 1€

Fig. 3E Thermal Deformation Plot for Layout with Axial Restraints

44



FE CheckStress : SE / SA - [D:\CheckStress\MBF\AxialSupport_01.res ()]
File Wiew ©Cptions Window Help

S HE BRAKAKX O

Z* »
0.75 I l

. 0.50 '

0.25

¢
I 0.00 ; (_

S ‘I _

| £

[~
|l»

Fig. 3F Thermal Stress Contour Plot for Layout with Axial Restraints
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Sample: 4 (WeightSupports 00 and 01)

This problem illustrates how to select and locate vertical supports to carry piping deadweight at operating
condition.

Fig. 4A shows a practical problem with 10” NB Standard schedule pipe from equipment nozzle at node 5
upto the reducer starting at node 30, 8" NB Standard schedule pipe from this reducer to the pump nozzle
at node 40, and a 6” NB Standard schedule branch line from the welding tee at node 25 to the equipment
nozzle at node 125.

The thermal stress contour plot given in Fig. 4B confirms that the piping system is highly flexible and
hence meets the code requirement for thermal load. Fig. 4C shows the deflected shape for sustained load
(i.e., mainly deadweight). It is observed that the weight of (i) the horizontal line from node 5 to node 15
and (ii) a major portion of the vertical riser from node 15 to node 20 is carried by the equipment nozzle at
node 5; on the other hand, the pump nozzle at node 40 carries the weight of (i) the horizontal line from
node 20 to node 40, (ii) the valve portion of the branch line from node 25 to node 125 and (iii) a small
portion of the vertical riser from node 15 to node 20. The deformation response for deadweight, in turn,
generates large forces and moments and hence large sustained stresses at nozzle nodes 5 and 40 as
shown in Fig. 4D for sustained stress contour plot.

Fig. 4E shows the same layout with variable spring hangers attached at the bends at nodes 20 and 115,
which carry piping deadweight and provide negligible restraint to thermal movement from cold to hot
condition and vice versa.

The thermal stress and sustained stress contour plots given in Fig. 4F and Fig. 4G confirm that the piping
system with hangers is code complaint for both sustained and thermal load cases.
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Fig. 4F Thermal Stress Contour Plot for Layout with Hangers
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Sample: 5 (Condensate 00, 01 and 02)

This practical problem illustrates how to place resting steel supports to carry the weight of the system with
operating fluid as well as to modify the layout in order to re-direct thermal growth to comply with code
stress requirements.

Fig.5A shows the initial layout where condensate from a tank is extracted by the pump suction lines.
When one pump is operating, the other one is 100% standby.

It is observed from the Fig. 5B that the pipeline from node 10 to node 100 thermally grows in the —Z
direction, whereas the two pump suction lines, one from node 120 to node 180 and the other from node
110 to node 250, thermally grow in the +Z direction. So, the straight pipe between nodes 100 and 120
(with a welding tee at node 110) experiences two opposing deflection patterns. The pipe portion between
nodes 110 and 120 is being deflected in the +Z direction like a rigid stick; on the other hand, the portion
between nodes 100 and 110 is being bent at tee node 110 as the node 100 deflects in —Z direction. This
deflection response, in turn, produces high strains and thermal stresses locally at the tee node 110, as
shown in Fig. 5C.

In order to reduce the high local thermal stresses at node 110, we cut the straight pipe between nodes
100 and 120 into two parts; one part is the pipe from node 100 to node 110 and the second part is from
node 110 to node 120. We then shifted the second part downstream towards the two pumps, resulting in
the modified layout shown in Fig. 5D. Fortunately, this shift of pipe downstream would not adversely
increase the pressure drop between the tank at node 10 and the pumps at nodes 180 and 250.

From the thermal deformation plot for this revised layout shown in Fig. 5E, it is observed that the two
pump suction lines from the suction nozzles to the welding tee at node 111 have almost equal thermal
growth in the +Z direction, thereby moving the branch pipe between nodes 111 and 300 as a rigid stick
resulting in low thermal stresses in that branch pipe as seen in Fig. 5F. In addition, it is observed that the
pump suction lines from the bend node 100 to the pump suction nozzles thermally grow in the +Z
direction, whereas the pipe from the tank node 10 to the bend node 90 grow in the —Z direction; this
opposing deflections rotate the inter connecting pipe between nodes 90 and 100 like a “see-saw” in the
horizontal XZ plane, resulting in low thermal stresses in this region, as observed in Fig. 5F.

Although the thermal stress criteria have been met, the weight stresses exceed the sustained stress
allowable, as illustrated by many red and orange areas in the sustained stress contour plot given in Fig
5G. This is because there are no vertical supports (excluding the 3 nozzles and a variable spring hanger
at node 52) to carry the weight of the system.

Now, vertical resting supports are introduced as shown in Fig.5H and the corresponding sustained stress
(i.e., weight + pressure) contour plot (with most areas in blue) shown in Fig.5I confirms that the sustained
stresses are well below the allowable values.
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Fig. 5C Thermal Stress Contour Plot
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Fig. 5F Thermal Stress Contour Plot for Revised Layout
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Fig. 5G Sustained Stress Contour Plot for Revised Layout
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Appendix G

Errors and Descriptions

This Appendix presents the list of errors, their descriptions and the necessary actions to be taken.

1.

10.

"Invalid Entry. Starting Node number should be a Numeric value."

Starting Node number specified is hot a numeric value. Please enter only numeric value.
"Invalid Entry. Node Increment should be a Numeric value."

Node Increment specified is not a numeric value. Please enter only numeric value.
"Invalid Entry. Staring Node number should be <10000."

Node number cannot be more than or equal to 10000. Please reenter the starting Number below
10000.

"Invalid Entry. Node Increment should be < 10000."

Node Increment value is too high. Node nhumber cannot be more than or equal to 10000. Please
reduce the Node Increment value.

"Cannot determine product. Contact Program vendor for details”

Some of the files required for the translator either moved or deleted. Please reinstall the product
or contact program vendor for details.

"Cannot initialize application. Contact Program vendor for details.”

Contact program vendor immediately.

"Invalid Data Type. Expected = 'Real’ Available ='String

a. When reading the Plant Design neutral file, one of the field values in a line is expected to
be Real number format. But the field is filled with string format. Translator unable to read
that field, so it will show an error message with a line number and Entire line Data and
the above message. User needs to check that particular field and modify to Real number
format and need to transfer the file.

b. For example, Outer Diameter of a pipe is expected in Real Number format like “4”, But in
neutral file it may be like “4inch”. In this case translator will give the above error message.
User needs to remove “inch” from that field and save that neutral file then need to
transfer.

"Improper Bore or Weight Units. Check the Neutral File."

Bore and Weight units entered in neutral file are invalid. Translator will expect Bore Unit as either
“IN” or “MM” and Weight unit as either “KG” or “LB”. If any value other than the above is specified,
the translator will show error message containing the line number, Entire line and the above
message. User needs to check unit used then needs to transfer.

"Wrong Neutral File. No Piping Elements available to Read..."

Translator expects at least any one piping component present in the Neutral file. If not, it will
show the above error message. User needs to check the Plant Design Neutral file.

"Number of Fields available in the above Line < The Required Fields.”

Translator expects some of the fields in a line from the Plant Design Neutral file. If not available, it
will show the above said message with Line number and that particular line. User needs to check
and correct that line and then need to transfer or contact program vendor for more details.
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11. "Error in Mapping Data Base. Check the Data Bases."

12.

13.

Improper changes were made to the Mapping Database. Check the entries made carefully.

"Node number <Number> is defined twice in the Neutral file. Check the neutral file and
proceed."

The node number specified above is defined two times i.e., for the same node number X, Y and Z
coordinate values specified in two places in the Plant Design Neutral file. User needs to check the
neutral file.

"The Node number exceeded 10000. Check the 'Start Node' and ‘Node Increment'."

During rearrange of node number, the new node is crossing 10000, which is not correct. Please
reduce the “Start Node number” and “Node number Increment” values and try again.
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Appendix H

Release Notes on checkSTRESS Version 9.10

Following piping codes are updated.
o ASME B31.1 (2014)
o ASME B31.3 (2014)
New feature added to show and print Hanger Report.

New feature added to transfer the model in ENGLISH units to checkSTRESS, if the value of the
attribute  "UNITS-CO-ORDS" is defined as "INCH" in PCF file for checkSTRESSPCF,
checkSTRESS Il PCF and checkSTRESS Nuke PCF.

Product is now fully compatible with Windows 10 and Windows Server 2012 or later. This version
of product does not require .Net Framework 1.0 to be installed and may require .Net Framework
2.0, if the same is not already enabled in Windows.

Release Notes on checkSTRESS Version 9.00

Following piping codes are updated.
o ASME B31.1 (2012)
o ASME B31.3 (2012)
o ASME B31.4 (2012)
o ASME B31.5 (2013)
o ASME B31.8 (2012)
o EN 13480 (2012)
o ASME B31.9 (2008)
o CODETI (2006)
Hanger catalog "COMET" has been updated to include two new ranges, V4 and V5.

USER-DEFINED ALLOWABLE LOADS: New feature added to define "User Allowable Loads" for
Anchors and Nozzles through Misc > User Allowables. The allowables thus defined are compared
against calculated loads and printed in Support Load Summary outputs. If the calculated loads
exceed the allowables, they are highlighted in red.

New feature added to read Thermal Anchor Movement (TAM) and Allowable Nozzle Loads
defined in 3D Plant Design software. Refer to checkSTRESSPCF.pdf / checkSTRESSPDMS.pdf /
checkSTRESSCADMATIC.pdf for details.

New feature added to print analysis summary. Using this feature, the following can be printed to a
printer, a PDF file, a text file or a CSV (comma separated values) file.

a. Model input data

b. Code compliance results for ten (10) highest stress node points

c. Anchor / Nozzle Qualification Summary and

d. Status of Resting Supports / Limit Stops

e. Bill of Quantities, Weight & Centre of Gravity and Table of Contents

Static seismic "g" load is included in all versions of checkSTRESS.
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Edit Layout - Enhancements

New feature added to calculate local shell stiffnesses for nozzles connected to spherical shells.

New feature added to calculate Angular Stiffness of Bellows when the Axial Stiffness and Mean
Diameter of Bellows are input.

Four digit year format is included in both "Print" and "Print to file" option.

New feature added to Copy and Paste rows (with Element (from Layout), Material, Section and
Load properties). This can be performed through Ctrl+C and Ctrl+V. This new feature will also
allow to Copy and Paste multiple rows of layout. This can be performed through Layout Frame-
>Edit->Copy command. Multiple rows of Copy and Paste is valid only for Layout and NOT for
Materials, Loads and Sections.

UNDO: can now perform an UNDO operation 1024 times (includes most user-input actions
through Layout, List and Graphics windows).

REDO: can now perform a REDO operation 1024 times (includes most user-input actions through
Layout, List and Graphics windows).

Length of the Material Name, Section Name, Load Name, Beam Material Name, Beam Section
Name and Beam Load Name is increased to 5 from 3.

New feature added to define Anchor and Specified displacements in the local coordinate system.

New feature added to change Occasional load factor (k) for EN13480 piping code, available
under Layout window > Options > Analysis > Code > EN13480.

DIN Flange library is now included in CheckSTRESS.
New feature added to combine current PIPE/BEND element with previous PIPE element.
New feature added to split an element into multiple segments.

New feature added to define Forces and Moments as part of Sustained Load / Expansion Load
(T1) using Force Dialog.

New feature added to Find and Replace Element / Data types / Materials / Sections / Loads. This
can be performed through Edit->Find and Replace or using Ctrl+H.

Improved title description for graphical plot of Stresses, Stress Ratios and Deflected shapes.

New feature added to Find and Repeat Find text inside comments. This can be performed
through View->Find Text (Ctrl+Shift+F). Repeat Find can be performed by pressing "Ctrl+F3".

Double clicking on a comment row will allow the user to edit/copy/paste strings from Windows
clipboard.

New feature added for redefining a model's vertical axis without affecting the layout of the piping
system. Redefining a model's vertical axis will automatically redefine elements, data types,
seismic G factors.

New feature added to show stress units in color coded stresses plot.

Double clicking the left mouse button on any area inside the Graphics window redefines that area
as the center point of graphical display.

New buttons added to define direction of Limit Stop and Skewed Restraint in Axial, Shear y and
Shear z directions of piping while inputting.

Mouse Scroll Button Up and Down will Zoom In and Zoom Out the graphics.

New feature added to toggle lists. Ctrl + Left Arrow key for Previous List and Ctrl + Right Arrow
key for Next List.
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e checkSTRESS now updated to have Node numbers up to 99,999 from the current 9,999.
¢ New option added to include single weight of flange from ANSI and EUROPEAN flange library.
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